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This standard is issued under the fixed designation D4015; the number immediately following the designation indicates the year of
original adoption or, in the case of revision, the year of last revision. A number in parentheses indicates the year of last reapproval. A
superscript epsilon (¢) indicates an editorial change since the last revision or reapproval.
¢! NOTE—Editorially corrected Eq 28 in February 2017.

1. Scope* 1.4 Significant Digits—All recorded and calculated values

1.1 These test methods cover the determination of shear
modulus and shear damping as a function of shear strain
amplitude for solid cylindrical specimens of soil in intact and
remolded conditions by vibration using resonant column de-
vices. The vibration of the specimen may be superposed on a
controlled static state of stress in the specimen. The vibration
apparatus and specimen may be enclosed in a triaxial chamber
and subjected to an all-around pressure and axial load. In
addition, the specimen may be subjected to other controlled
conditions (for example, pore-water pressure, degree of
saturation, temperature). These test methods of modulus and
damping determination are considered nondestructive when the
shear strain amplitudes of vibration are less than 107 %
(107 in./in.), and many measurements may be made on the
same specimen and with various states of static stress.

1.2 Two device configurations are covered by these test
methods: Device Type 1 where a known torque is applied to the
top of the specimen and the resulting rotational motion is
measured at the top of the specimen, and Device Type 2 where
an uncalibrated torque is applied to the top of the specimen and
the torque transmitted through the specimen is measured by a
torque transducer at the base of the specimen. For both devices,
the torque is applied to the active end (usually top) of the
specimen and the rotational motion also is measured at the
active end of the specimen.

1.3 These test methods are limited to the determination of
the shear modulus and shear damping, the necessary vibration,
and specimen preparation procedures related to the vibration,
etc., and do not cover the application, measurement, or control
of the axial and lateral static normal stresses. The latter
procedures may be covered by, but are not limited to, Test
Method D2850, D3999/D3999M, D4767, D5311/D5311M, or
D7181.

! These test methods are under the jurisdiction of ASTM Committee D18 on Soil
and Rock and are the direct responsibility of Subcommittee D18.09 on Cyclic and
Dynamic Properties of Soils.

Current edition approved Oct. 1, 2015. Published November 2015. Originally
approved in 1981. Last previous edition approved in 2007 as D4015 - 07. DOI:
10.1520/D4015-15E01.

shall conform to the guide for significant digits and rounding
established in Practice D6026.

1.4.1 The procedures used to specify how data are collected/
recorded and calculated in this standard are regarded as the
industry standard. In addition, they are representative of the
significant digits that should generally be retained. The proce-
dures used do not consider material variation, purpose for
obtaining the data, special purpose studies, or any consider-
ations for the user’s objectives; and it is common practice to
increase or reduce significant digits of reported data to be
commensurate with these considerations. It is beyond the scope
of this standard to consider significant digits used in analysis
methods for engineering design.

1.4.2 Measurements made to more significant digits or
better sensitivity than specified in this standard shall not be
regarded a nonconformance with this standard.

1.5 Units—The values stated in SI units are to be regarded
as standard. The values given in parentheses are mathematical
conversions to inch-pound units, which are provided for
information only and are not considered standard. Reporting of
test results in units other than SI shall not be regarded as
nonconformance with these test methods.

1.5.1 The converted inch-pound units use the gravitational
system of units. In this system, the pound (Ibf) represents a unit
of force (weight), while the unit for mass is slugs. The
converted slug unit is not given, unless dynamic (F = ma)
calculations are involved.

1.5.2 It is common practice in the engineering/construction
profession to concurrently use pounds to represent both a unit
of mass (Ibm) and of force (Ibf). This implicitly combines two
separate systems of units; that is, the absolute system and the
gravitational system. It is scientifically undesirable to combine
the use of two separate sets of inch-pound units within a single
standard. As stated, this standard includes the gravitational
system of inch-pound units and does not use/present the slug
unit for mass. However, the use of balances or scales recording
pounds of mass (Ibm) or recording density in Ibm/ft® shall not
be regarded as nonconformance with this standard.

*A Summary of Changes section appears at the end of this standard
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1.6 This standard does not purport to address all of the
safety concerns, if any, associated with its use. It is the
responsibility of the user of this standard to establish appro-
priate safety and health practices and determine the applica-
bility of regulatory limitations prior to use.

2. Referenced Documents

2.1 ASTM Standards:*

D653 Terminology Relating to Soil, Rock, and Contained
Fluids

D2166/D2166M Test Method for Unconfined Compressive
Strength of Cohesive Soil

D2216 Test Methods for Laboratory Determination of Water
(Moisture) Content of Soil and Rock by Mass

D2850 Test Method for Unconsolidated-Undrained Triaxial
Compression Test on Cohesive Soils

D3740 Practice for Minimum Requirements for Agencies
Engaged in Testing and/or Inspection of Soil and Rock as
Used in Engineering Design and Construction

D3999/D3999M Test Methods for the Determination of the
Modulus and Damping Properties of Soils Using the
Cyclic Triaxial Apparatus

D4753 Guide for Evaluating, Selecting, and Specifying Bal-
ances and Standard Masses for Use in Soil, Rock, and
Construction Materials Testing

D4767 Test Method for Consolidated Undrained Triaxial
Compression Test for Cohesive Soils

2 For referenced ASTM standards, visit the ASTM website, www.astm.org, or
contact ASTM Customer Service at service @astm.org. For Annual Book of ASTM
Standards volume information, refer to the standard’s Document Summary page on
the ASTM website.
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D5311/D5311M Test Method for Load Controlled Cyclic
Triaxial Strength of Soil

D6026 Practice for Using Significant Digits in Geotechnical
Data

D7181 Test Method for Consolidated Drained Triaxial Com-
pression Test for Soils

3. Terminology

3.1 Definitions—For definitions of other terms used in these
test methods, see Terminology D653.

3.2 Definitions of Terms Specific to This Standard:

3.2.1 damping capacity D [unitless, typically expressed in
%], n—in resonant column systems, is related to the component
of the dynamic shear modulus that lags the applied shear stress
by 90° degrees.

3.2.2 Device Type 1, DT, n—in resonant column systems, a
resonant column system as shown in Fig. 1 where the passive
end platen is directly connected to the Fixed Base (no torque
transducer), a calibrated vibratory torque is applied to the
active end, and rotation is measured at the active end.

3.2.2.1 Discussion—The vibration excitation device may
incorporate springs and dashpots connected to the active-end
platen, where the spring constants and viscous damping coef-
ficients must be known. The rotational inertia of the active-end
platen and portions of the vibration excitation device moving
with it must be known.

3.2.3 Device Type 2, DT2, n—in resonant column systems, a
resonant column system as shown in Fig. 1 where the passive
end platen is connected to a torque transducer, an uncalibrated

Top Platen Rotation, 6,

Applied Torque, 7,

Top Platen System Inertia, J,
Active End Platen

Specimen with Diameter, d,
Length, L, Density, p, Shear
Modulus, G, Damping, D
Passive End Platen, J,

Torque Transducer, k,,, ¢, (DT 2)

For Device Type 1, no torque transducer is needed and the Passive End Platen is connected to the Fixed Base.
FIG. 1 Resonant-Column Schematic for Both Device Types 1 and 2
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torque is applied to the active end, torque is measured by the
torque transducer at the passive end, and rotation is measured
at the active end.

3.2.3.1 Discussion—The vibration excitation device may
incorporate springs and dashpots connected to the active-end
platen, but the spring constants and viscous damping coeffi-
cients are not needed. The rotational inertia of the active-end
platen and portions of the vibration excitation device moving
with it also are not needed.

3.2.4 dynamic shear modulus, G* [FL'2], n—in resonant
column systems, is the ratio of shear stress to shear strain under
vibratory conditions (also known as complex shear modulus).

3.2.5 equivalent elastic shear modulus G [FL?] n—in
resonant column systems, is the component of the dynamic
shear modulus that is in-phase with the applied shear stress.

3.2.6 resonant-column system, n—a system as shown in Fig.
1 consisting of a cylindrical specimen or column of soil
enclosed with a flexible membrane that has platens attached to
each end and where a sinusoidal vibration excitation device is
attached to the active-end platen and where the other end is the
passive-end platen that is rigidly fixed.

3.2.7 specimen shear strain 7y, [unitless, frequently ex-
pressed as %], n—in resonant column systems, is the average
shear strain in the specimen where the shear strain in each cross
section varies from zero along the axis of rotation to a
maximum at the perimeter of the specimen.

3.2.7.1 Discussion—The radius for calculating average
shear strains vary depending on soil type, strain level, confin-
ing stress, etc. The default value of the radius for calculating
average strain is 0.4*diameter but values in the range of 0.33
to 0.40*diameter may be used if the value is documented in the
report.

3.2.8 system resonant frequency f.[s"'], n—in resonant col-
umn systems, for Device Type 1 is the lowest frequency at
which the rotational velocity at the active end is in phase with
the sinusoidal excitation torque and for Device Type 2, is the
lowest frequency at which the rotational motion at the active
end is a maximum.

4. Summary of Test Method

4.1 The resonant column device is shown schematically in
Fig. 1. In the resonant column test, a cylindrical soil specimen,
usually enclosed with a thin membrane, is subjected to an
imposed static axial and lateral stress condition. Torsional
sinusoidal vibrations are applied at the top of the soil specimen
and the rotational response is measured. The frequency of
excitation is varied until the system resonant frequency is
achieved as described in 3.2.8. Given the geometry, mass and
system parameters, the equivalent elastic shear modulus and
damping capacity can be determined at a measured level of
excitation vibration. The amplitude of vibration (which is
related to shear strain) is typically varied to measure the
variation of modulus and damping as a function of shear strain.
The test is usually conducted at levels of shear strain between
0.00001 % and 0.2 %. (The upper limit of shear strain is
dependent on the specimen stiffness and the maximum torque
capability of the excitation system.) For specimens where the

maximum shear strain measured is of the order of 0.01 %, the
test is often conducted at several different sets of static axial
and lateral stress conditions to measure the variation of moduli
and damping with static stress states. The test results are
dependent on sample quality/specimen disturbance which are
beyond the scope of this standard.

5. Significance and Use

5.1 The equivalent elastic shear modulus and damping
capacity of a given soil, as measured by the resonant column
technique herein described, depend upon the strain amplitude
of vibration, the state of effective stress, and the void ratio of
the soil, temperature, time, etc. Since the application and
control of the static axial and lateral stresses and the void ratio
are not prescribed in these methods, the applicability of the
results to field conditions will depend on the degree to which
the application and control of the static axial and lateral
stresses and the void ratio, as well as other parameters such as
soil structure, duplicate field conditions. The techniques used
to simulate field conditions depend on many factors and it is up
to the engineer to decide on which techniques apply to a given
situation and soil type. The results of these tests are useful for
calculations involving soil-structure interaction and seismic
response of soil deposits.

Note 1—The quality of the results produced by this standard is
dependent on the competence of the personnel performing it, and the
suitability of the equipment and facilities. Agencies that meet the criteria
of Practice D3740 are generally considered capable of competent and
objective testing/sampling/inspection/etc. Users of this standard are cau-
tioned that compliance with Practice D3740 does not in itself assure
reliable results. Reliable results depend on many factors; Practice D3740
provides a means of evaluating some of those factors.

6. Apparatus

6.1 General—The complete test apparatus is shown sche-
matically in Fig. 1 and includes the platens for holding the
specimen in the pressure cell, the vibration excitation device
(torque motor) , transducers for measuring the response, the
control and readout instrumentation, and auxiliary equipment
for specimen preparation. The theory for the resonant column
is provided in Annex Al. The entire apparatus is generally
enclosed within a pressure chamber (commonly referred to as
a triaxial cell). For some apparatus that can apply an axial load
to the specimen, the pressure chamber lid may be fitted with a
piston passing through the top.

6.2 Specimen Platens—Both the active-end and passive-end
platens shall be constructed of noncorrosive material having a
modulus at least ten times the modulus of the material to be
tested. Each platen shall have a circular cross section and a
plane surface of contact with the specimen, except that the
plane surface of contact may be roughened to provide for more
efficient coupling with the ends of the specimen. Roughening
and flow of fluids into or from the specimen may be accom-
plished by rigidly fastening porous disks to the platens. The
diameter of platens shall be equal to or greater than the
diameter of the specimen. The construction of the platens shall
be such that their stiffness is at least ten times the stiffness of
the specimen.
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6.2.1 The active-end platen may have a portion of the
excitation device, transducers, springs, and dashpots connected
to it. The transducers and moving portions of the excitation
device must be connected to the platen in such a fashion that
they are to be considered part of the platen, be counterbalanced
to maintain rotational symmetry and have the same motion as
the platen for the full range of frequencies to be encountered
when testing soils.

6.2.2 The theoretical model used for the resonant-column
system represents the active-end platen, with all attachments,
as a rigid mass that is attached to the specimen; this mass may
also have massless springs and dashpots attached to it as shown
in Fig. 1. If springs are used, the excitation device and
active-end platen (without the specimen in place) form a
one-degree-of-freedom system having an undamped natural
frequency, f,,.

6.2.3 The passive-end platen must be rigidly fixed. It may
be assumed to be rigidly fixed when the inertia of it and the
mass(es) attached to it are at least 500 times the inertia of the
active-end platen (1)°.

6.2.4 For Device Type 2, a torque transducer is placed
between the passive end platen and the rigidly fixed base. The
torque transducer even though relatively stiff in torsion (see
6.4), must allow for some small rotation of the passive end
platen in order to register the transmitted torque. The inertia of
the passive end platen system, J, must include the inertia of the
sensing head of the torque transducer which is rigidly fastened
to it. With no specimen in place, the passive end platen system
inertia, I along with the stiffness, kp, and damping coefficient,
c,, of the torque transducer constitute a single-degree-of-
freedom system which are accounted for in Eq A1.3.

6.3 Vibration Excitation Device (torque motor)—This shall
be a device capable of applying a sinusoidal torsional vibration
to the active-end platen to which the moving parts of the device
are rigidly coupled. The frequency of excitation shall be
continuously variable and have a range that typically includes
10 Hz to 1 kHz. For Device Type 1 where the torque is
measured at the active end, the excitation device shall have a
means of measuring the torque applied to the excitation device
that has at least 5 % accuracy of full scale output. If an
electromagnetic excitation device is used, the voltage drop
across a fixed, temperature-and-frequency-stable power resis-
tor in series with the excitation device is proportional to
applied torque (Note 2). For Device Type 2, the torque is
measured at the passive end with a torque transducer, see 6.4.

Norte 2—Calibrations at more than one frequency may be needed when
testing frequencies vary over a wide range. Use of several calibration rods
with differing torsional stiffness may be needed.

6.4 Passive End Torque Transducer—This torque transducer
for Device Type 2 must be waterproof and insensitive to
ambient pressure and temperature changes for the expected
values. It may be a transducer that also measures axial force.
The torque transducer must have a torque capacity of at least
twice the maximum torque capability of the vibration excita-
tion device, a linearity of *0.5 % of full scale output,

3 The boldface numbers in parentheses refer to a list of references at the end of
this standard.

hysteresis less than *£0.1 % of full scale output, and repeat-
ability better than +0.5 % of full scale output. If the transducer
is used to measure axial force, the specifications must be
similar to those for torque. The transducer must be rigidly
connected to the chamber base and the sensing head of the
torque transducer shall be rigidly connected to the passive end
platen.

6.5 Sine Wave Generator—The sine wave generator is an
electric instrument capable of producing a sinusoidal current
with a means of adjusting the frequency over the entire range
of operating frequencies anticipated. This instrument shall
provide sufficient power to produce the desired vibration
amplitude, or its output may be electronically amplified to
provide sufficient power.

6.6 Vibration-Measuring  Devices  and  Readout
Instruments—These devices and instruments shall be calibrated
with an accuracy of 5 % and must be traceable to a government
standards agency. The vibration-measuring devices shall be
acceleration, velocity, or displacement transducers that can be
attached to and become a part of the active-end platen. The
transducer(s) shall be mounted to produce a calibrated electri-
cal output that is proportional to the rotational acceleration,
velocity, or displacement. The readout instruments must have a
frequency resolution of at least 0.1 Hz. It also is necessary to
have an electronic device for establishing the phase difference
between the applied and/or measured torque and resulting
rotational motion for establishing the system resonant fre-
quency.

6.6.1 For Device Type 1, an x-y-time oscilloscope may be
used for this purpose. The electronic device must have ampli-
fiers with sufficient gain to observe the torque motor input and
motion transducer outputs over the entire range of frequencies
anticipated. For measurement of damping by the free-vibration
method, and for calibration of the apparatus damping, the
readout instrument shall be capable of recording the decay of
free vibration with appropriate response time. A digital x-y-
time oscilloscope may be used for this purpose. For Device
Type 2, a dual channel readout device or a spectrum analyzer
must be used to measure the magnitude and phase (or real and
imaginary) components of the measured 6, /T at the resonant
frequency.

6.7 Support for Vibration Excitation Device—It may be
necessary to support all or a portion of the weight of the
active-end platen and excitation device to prevent excessive
axial stress or compressive failure of the specimen. This
support may be provided by a spring, counterbalance weights,
or pneumatic device as long as the supporting system does not
prevent axial movement of the active-end platen and as long as
it does not alter the vibration characteristics of the excitation
device.

6.8 Temporary Platen Support Device—Temporary support
of the active-end platen may be any clamping device that can
be used to support the platen during attachment of vibration
excitation device to prevent specimen disturbance during
apparatus assembly. This device is to be removed prior to the
application of vibration.
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6.9 Specimen Dimension-Measuring Devices—Dimension-
measuring devices are needed to measure portions of the
apparatus during calibration and specimen diameter and length.
Any suitable device may be used to make these measurements
except that the device(s) used to measure the length and
diameter of the specimen must not deform or otherwise affect
the specimen. Specially designed perimeter tapes®* that measure
circumference but read out in diameter are preferred for
measuring specimen diameters. Measurement accuracies are
specified in 7.2.

6.10 Balances—Devices for determining the mass of the
soil specimens as well as portions of the device during
calibration. All measurements of mass should be accurate to
0.1 %. (Guide D4753)

6.11 Specimen Preparation and Triaxial Equipment—These
methods cover specimen preparation and procedures related to
the vibration of the specimen and do not cover the application
and control of static axial and lateral stresses. Any or all of the
apparatus described in Test Method D2166/D2166M, D2850,
or D4767 may be used for specimen preparation and applica-
tion of static axial and lateral stresses. Additional apparatus
may be used for these purposes as needed.

6.12 Miscellaneous Apparatus—The miscellaneous appara-
tus consists of specimen trimming and carving tools, a mem-
brane expander, remolding apparatus, and moisture content
cans as required.

7. Test Specimen

7.1 General—These methods are limited to the special
specimen preparation procedures related to the vibration and
resonant-column technique. Since the resonant-column test
may be conducted in conjunction with controlled static axial
and lateral stresses, the provisions for preparation of specimens
in Test Method D2166/D2166M, D2850, or D4767 may be
applicable or may be used as a guide in connection with other
methods of application and control of static axial and lateral
stresses.

7.2 Specimen Size Limitations—Specimens shall be of uni-
form circular cross section with ends perpendicular to the axis
of the specimen. Specimens shall have a minimum diameter of
33 mm (1.3 in.). The largest particle contained within the test
specimen shall be one sixth of the specimen diameter. If, after
completion of a test, it is found that larger particles than
permitted are present, indicate this information in the report of
test data under “Remarks.” The length-to-diameter ratio shall
be not less than 2 or more than 7 except that, when a static axial
stress greater than the lateral stress is applied to the specimen,
the ratio of length to diameter shall be between 2 and 3. Take
diameter measurements to the nearest 0.25 mm (0.01 in.), at the
third points along the specimen length and average them. Take
height measurements, to the nearest 0.25 mm (0.01 in.), at four

#The sole source of supply of the apparatus known to the committee at this time
is PI Tape, Box 398, Lemon Grove, CA 92045 (http://www.pitape.com). If you are
aware of alternative suppliers, please provide this information to ASTM Interna-
tional Headquarters. Your comments will receive careful consideration at a meeting
of the responsible technical committee,’ which you may attend.

quadrants and average them. For determination of moisture
content (Test Method D2216), secure a representative speci-
men of the cuttings from intact specimens, or of the extra soil
for remolded specimens, placing the specimen immediately in
a covered container.

7.3 End Coupling for Torsion—For torsional motion, com-
plete coupling of the ends of the specimen to the specimen cap
and base must be assured. Coupling for torsion may be
assumed if the mobilized coefficient of friction between the end
platens and the specimen is less than 0.2 for all shear strain
amplitudes. The coefficient of friction is approximately given
by:

G
Mobilized Coefficient of Friction = };T (1)
where:
y = shear strain amplitude (see Calculations section),
G = shear modulus (see Calculations section), and
o' = effective axial stress.

Note 3—The shear strain is not in % for this calculation.

7.3.1 When this criterion is not met, other provisions such
as the use of adhesives or other friction increasing measures
must be made in order to assure complete coupling (2). In such
cases, the effectiveness of the coupling provisions shall be
evaluated by testing two specimens of the same material but of
different length. The lengths of these specimens shall differ by
at least a factor of 1.5. The provisions for end coupling may be
considered satisfactory if the values of the shear modulus for
these two specimens of different length do not differ by more
than 10 %.

8. Apparatus Properties (see Note 4)

Norte 4—Practice D3740 provides information on calibration intervals,
records, and quality assurance.

8.1 Motion Transducers—Motion transducers shall be cali-
brated with an independent method to ensure calibration
accuracy within 5 % and must be traceable to a government
standards agency.

8.1.1 Rotational Motion Transducer—The rotational motion
at the free end of the soil specimen is normally measured using
linear motion transducer(s) mounted at a radial distance r, from
the axis of rotation. Linear motion transducers that are sensi-
tive to acceleration, velocity or displacement may be used.
Rotational measuring transducers are acceptable as well. (See
6.6.)

8.1.1.1 The rotation transducer sensitivity S, in terms of
millivolts/radian is computed as follows:

For an accelerometer transducer with sensitivity S, [mV/g]
the rotation transducer sensitivity at frequency f [Hz] is:

Sy =S,r,(2mf)2(1/9.81) )

a't

For a velocity transducer with sensitivity S, [mV/(m/s) ] the
rotation transducer sensitivity is:

So=8,r(2mf) (3)

For a displacement transducer with sensitivity S, [mV/m] the
rotation transducer sensitivity is:

Sy=S,r, 4)
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Rotation of the top of the specimen is given by:
RTrdg[mV]

{mv] (5
S, Tad

where RTrdg is the output of the rotation transducer.

0[rad] =

8.2 Active-End Rotational Inertia (only needed for Device
Type 1)—The rotational inertia, J,, of the active-end platen
shall be determined with all transducers and rigid attachments,
including attached portions of the vibration excitation device,
securely in place. The rotational inertia of the concentric solid
cylindrical components of the active-end platen and its attach-
ments is computed from:

1o
(), = g2 Md; (6)

where:

M; = mass of i solid cylindrical component,

d;, = diameter of i solid cylindrical component, and

n = number of solid cylindrical components.

Transducers and other masses attached to this platen can be
accounted for by:

()= 30, + M, ) %)
where
J; = rotational inertia of the i component,
M; = mass of i component,
r; = distance from the platen axis to center of mass for /™
component, and
n = number of components attached to active-end platen

and not covered in determination of (J,);.

The total rotational inertia for the active end is given by:
‘]a: (‘]a)]+(‘]a)2 (8)

8.2.1 Acceptable alternate procedures for determining J,, are
provided in A2.1.

8.3 Apparatus Resonant Frequencies, Spring Constants,
and Damping Constants (only needed for Device Type 1)—(See
Note 5) Apparatus resonant frequencies and spring constants
are defined only for Device Type 1 that has springs attached to
the active-end platen system. To determine the resonant
frequencies, set up the apparatus complete with active-end
platen and O-rings used to seal the membranes, but with no
specimen. Vibrate at low amplitude and adjust the frequency of
vibration until the input torque is in phase with the velocity of
the active-end platen system. This apparatus resonant fre-
quency is f,. The apparatus spring constant, k,, is calculated
from:

k=2 f), 9)
where J, is defined in the previous subsection.

Note 5—Device Type 2 apparatus may or may not have springs and
dashpots attached to the active end platen but by Eq A1.3, these and the
active end platen inertia do not affect the determination of shear modulus
and damping of the soil.

8.3.1 Apparatus Damping Coefficient for Device Type 1
apparatus without springs attached to the active end platen.

Device Type 1 without springs may still have a damping
constant to account for back EMF, aerodynamic drag, vibration
of wires attached to the platen, and eddy currents. To measure
the damping constants for the apparatus, attach the same
masses as used for the determination of apparatus resonant
frequencies. For apparatus without springs attached to the
active-end platen, insert the calibration rod described in the
previous subsection. Vibrate the system at the resonant fre-
quency and measure the torque and rotational motion. The
apparatus damping coefficient is given by:

_ Tappt _ Tappt _ Tappi®
€= B0 _ do _ d% (10)
dt dr*

where:
Tuppl amplitude of applied torque,
0 = amplitude of rotation,
do . . .
i amplitude of rotational velocity,
d6 . . .
o amplitude of rotational acceleration, and
® = resonant circular frequency of the system at

calibration (=2mf).

8.3.2 An acceptable alternate method for calculating the
apparatus damping coefficient, ¢, is given in A2.2. Reference
(3) provides a convenient method for determining both J, and
¢, that makes use of the program given in Appendix XI.

8.4 Torque Motor Torque/Current Characteristics (only
needed for Device Type 1)—For Device Type 1 apparatus
without springs attached to the active-end platen, insert the
calibration rod as described earlier. For Device Type 1 appa-
ratus with springs attached, set up the apparatus complete with
active-end platen and O-rings but no specimen. For either
setup, determine the resonant frequency of this single-degree-
of-freedom system consisting of the active-end platen and
apparatus spring (or calibration rod) by use of the same
procedure as described later in the procedures section. Then set
the frequency to 0.707 times the resonant frequency and apply
torque so that the vibration transducer output to the readout
device has a signal of at least ten times the signal due to
ambient vibrations and electrical noise when no torque is
applied. Read and record the output of the vibration transducer
and the current input to the torque generating instrument
(torque motor). Next, set the frequency to 1.414 times the
system resonant frequency and obtain the readings similar to
those at 0.707 times the resonant frequency. Calculate C; and
C, from:

C = 11
17 2CR, (an
62
.= CR,
where:
0, = active-end rotation at 0.707 times resonant frequency
(Note 6),
CR, = torque motor input (amps) at 0.707 times resonant

frequency (Note 7),
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6, = active-end transducer output at 1.414 times resonant
frequency (Note 6), and
CR, = torque motor input (amps) at 1.414 times resonant

frequency (Note 7).

Note 6—0, and 0, will be functions of frequency for velocity and
acceleration measuring transducers (see 8.1).

Note 7—If a current-measuring instrument is used, the units will be
amperes. Alternatively, voltage drop across a fixed resistance may also be
measured and the units will then be volts.

By use of C, and C,, the torque motor rating, TMR, is
obtained from:

TMR = 0.5k(C, + C,) (12)

where:
k = apparatus spring constant, k, (or for apparatus without
springs, the calibrating rod spring constant, k,,,).
The torque applied to the top platen by the torque generator
is given by:

T, =TMR-Trdg (13)

appl —
where:

Trdg input amps to the torque motor
TMR = torque motor rating from Eq 12.

8.5 Passive End Inertia and Torque Transducer Calibra-
tions (only needed for Device Type 2):

8.5.1 A torque transducer generally consists of a metallic
case containing a ‘“‘spring” instrumented to measure strain
where the strain is proportional to the applied torque. The
torque is applied to the spring through a sensing head protrud-
ing from the transducer case. The sensing head must be rigidly
connected to the passive end platen and provide the basis for
the passive end rotational inertia:

I, =T sassive praten T sens neaa (14)
where:
Jpassive paren = Calculated using Eq 6-8, and

frequently is provided by the transducer
manufacturer.

8.5.2 Alternative methods provided in A2.3.

8.5.3 The torque transducer sensitivity is given by the
manufacturer and must be traceable to a government standards
agency. The torque measured by the torque transducer is
calculated from:

sens head

TTrdg
1T TTsen (15)
where:
TTsens = Torque Transducer sensitivity typically in units of
mV/(N-m)
TTrdg = Voltage reading (mV) for the torque transducer.

9. Procedure

9.1 Test Setup—The exact procedure to be followed during
test setup will depend on the apparatus and electronic equip-
ment used and on methods used for application, measurement,
and control of the static axial and lateral stresses. However, the
specimen shall be placed in the apparatus by procedures that
will minimize the disturbance of the specimen. Particular care

must be exercised when attaching the end platens to the
specimen and when attaching the vibration excitation device to
the platens. A temporary support as discussed earlier may be
needed. For cases where isotropic static stresses are to be
applied to a membrane-enclosed specimen, liquid- or air-
confining media may be used for dry or partially saturated
specimens. For tests where complete saturation is important, a
liquid-confining medium should be used. Where the vibration
excitation device is located within the pressure chamber, an
air-liquid interface is acceptable as long as the liquid covers the
entire membrane that encloses the specimen.

9.2 Electronic Equipment—The power supplied to the
torque motor should be switched off. Connect the torque motor
to the sine wave generator (with amplifier, if required).
Connect the vibration transducers to the readout instruments.
Gradually apply power to the torque motor and adjust the
readout instruments according to the instruction manuals for
these instruments.

9.3 Measurements:
9.3.1 Device Type I:

9.3.1.1 Measurement of Resonant Frequency—The motion
of the active-end platen in conjunction with the applied torque
is used to establish resonance. Resonance is defined as the
lowest frequency where the torque is 90 degrees out-of-phase
with the rotational acceleration or displacement. This phase
relationship can be detected by observing the Lissajous figure
on an oscilloscope with the torque input signal and rotational
acceleration or displacement plotted as x-y. (Note 8) At the 90
degree phase relationship the figure will be an ellipse with its
axes vertical and horizontal. If a velocity transducer is used for
rotational measurement, the system resonance occurs when the
Lissajous figure forms a straight, sloping line. It is recom-
mended that the frequency be measured with a digital elec-
tronic frequency meter and be recorded to at least three
significant figures.

9.3.1.2 The determination of the lowest resonance can be
done by setting the torque excitation frequency (for example,
10 Hz) and power to as low a value as practical. Then increase
the frequency of excitation until the system resonant frequency
is obtained.

Note 8—The phase relationship between two signals may also be
computed by measurement of the time difference between zero crossings
of the two signals divided by the period of the oscillations (period =
L multiplied by 360 gives the phase in degrees. If the signals are not
frequency’, . .
cldan Sine waves, then a spectral analysis will have to be performed to get
accurate values for magnitude and phase (or real and imaginary compo-
nents) of the rotation/torque ratio. The magnitude of the rotation/torque
ratio multiplied by the cosine of the phase gives the real component of the
rotation/torque ratio and the same ratio multiplied by the sine of the phase
gives the imaginary component of the rotation/torque ratio.

9.3.1.3 Measurement of Strain—The strain amplitude mea-
surements shall be made only at the system resonant frequen-
cies. Thus, for a given torque, the vibration motion transducer
outputs recorded at the system resonant frequency give suffi-
cient information to calculate strain amplitude. To increase or
decrease strain amplitude, the applied torque must be increased
or decreased. After making a change in torque, the procedure of
9.3.1.1 must be followed to establish the corresponding system
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resonant frequency before the rotation transducer output can be
used to establish the new shear strain amplitude value.

9.3.1.4 Measurement of System Damping—Associated with
each shear strain amplitude and system resonant frequency is a
value of damping. Two methods are available for measuring
system damping: the steady-state vibration method and the
amplitude decay method. Both methods should give similar
results. The steady-state method is easier and quicker. It is
generally always used and the amplitude decay method is used
for occasional spot-checking. For the steady-state method, the
active-end transducer output and the applied torque must be
measured at each resonant frequency. The calculations are
outlined in the following section. For the free-vibration
method, with the system vibrating at the system resonant
frequency, cut the power to the vibration excitation device (see
Note 9) and record the output of the rotation transducer used in
establishing resonance as a function of time. This gives the
decay curve for free vibration. The calculations for damping
are outlined in the following section.

Note 9—The shut-off mechanism must create an open circuit with the
vibration excitation device and cannot be done by switching off the power
to amplifier. Without an open circuit, damping will be induced by current
flow in the circuit.

9.3.2 Device Type 2:

9.3.2.1 Measurement of Resonant Frequency—This is the
lowest frequency at which the active end rotation is a maxi-
mum. In addition to measuring the frequency, magnitude of
motion and magnitude of torque, the phase between the motion
at the active end and the torque at the passive end must be
determined (see Note 8).

9.3.2.2 Measurement of Strain Amplitude—The strain am-
plitude measurements shall be made only at the system
resonant frequencies. Thus, for a given torque, the vibration
motion transducer outputs recorded at the resonant frequency
give sufficient information to calculate strain amplitude. To
increase or decrease strain amplitude, the applied torque must
be increased or decreased. After making a change in torque, the
procedure of 9.3.2.1 must be followed to establish the corre-
sponding resonant frequency before the rotation transducer
output can be used to establish the new shear strain amplitude
value.

9.3.2.3 Measurement of System Damping—Damping is de-
termined from steady-state measurements of torque measured
at the base of the specimen (passive end), amplitude of motion
of the active end and the phase difference between them as
described in the next section.

10. Calculation

10.1 General—Calculations require the apparatus calibra-
tion factors and the physical dimensions and mass of the
specimen at the time resonant measurements are made. In
addition, for each static axial and lateral stress condition, one
data set should be measured for each vibration strain ampli-
tude. A data set consists of: duration of vibration (this time can
be used to calculate the number of vibration cycles), system
resonant frequency, active-end transducer output for both type
devices. For Device Type 1 additionally, the reading associated
with the applied torque, and if the amplitude decay method of

measuring damping is also going to be used, the free-vibration
amplitude decay curve. For Device Type 2, it is necessary to
measure the torque as well as the phase between the torque
transducer output and the motion at the active end of the
specimen (Note 8).

10.1.1 The calculations outlined in this section may all be
made by computer programs. For Device Type 1, a program for
making the calculations is provided in Appendix XI. For
Device Type 2, the program is given in Appendix X2. Other
programs may be used to make a portion or all of the
calculations as long as they provide identical results. The units
for the symbols in this section are given in Annex A3.

10.2 Soil Mass Density—The soil mass density, p, is given
by:

i 16
P=v (16)
where:
M = total mass of specimen, and
V= volume of specimen.

10.3 Specimen Rotational Inertia—The specimen rotational
inertia about the axis of rotation is given by:
 Md?

8

J (17)

where d = diameter of specimen.

10.4 Active-End Inertia Factors:
10.4.1 The active-end inertia factor, 7, is only needed for
Device Type 1 and is given by:

Ja AN
=3 - (7] (e
where:

J, = rotational inertia of active-end platen system as calcu-
lated earlier,

J = specimen rotational inertia as calculated earlier,

f, = apparatus resonant frequency (for apparatus without
springs attached to the active-end platen, this factor is
zero), and

[, = system resonant frequency.

10.5 Apparatus Damping Factors:
10.5.1 The apparatus damping factor, for Device Type 1 is
calculated from:

C
ADF, = —¢ (19)

where ¢, = apparatus damping coefficient as described by Eq
10 or A2.2.

10.6 Modified Magnification Factor:
10.6.1 The measured modified magnification factor is used
in calculating both modulus and damping. For Device Type 1,

it is calculated from:
ell ell
+iIm (20)
Tappi Tappi
where:

0 = rotational motion at the active end,

a

(MMFmeus)DTl = ‘/0‘)2|:Re (
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Tappl

w

torque applied to the active end, and
resonant frequency as defined in 9.3.1.1 or 9.3.1.2.

At resonance where the phase is —90 degrees, the real portion
becomes zero.

10.6.2 For Device Type 2, the measured magnification
factor is given by:

6([ etL
(MMF,,..)pr = J0*| Re +ilm (21)

Trr Trr

where:

6, = rotational motion at the active end,

77 = torque measured by the torque transducer at the

passive end, and
w = resonant frequency as described in 9.3.2.1.

10.7 Shear Modulus and Damping:

10.7.1 Governing Equation—For Device Type 1, substitut-
ing Eq 17 and 18 into Eq A1.2 with some rearrangement gives
the governing equation for the resonant column system in
non-dimensional form:

1

(MMF.,,.) (22)

DT1 = .
- Ta + lADFa + W
where A" is defined by Eq Al.4.
For Device Type 2, multiplying Eq A1.3 by w®/ and with the
assumption that wc, << k, gives:

J[ o)\ o\’
(MMFL‘AI(')DT2 = T( > COS}\,*"' [ L= ( (,07) :| )\‘*Sinx* (23)
P P

P

where 1" is defined by Eq Al1.4 and

o =1/2 (24)

10.7.2 Dimensionless Frequency Factor—The dimension-

component, Re(L"), and an imaginary component, Im(1"). It is
used in calculating modulus and damping by solving Eq 22 for
Device Type 1 or Eq 23 for Device Type 2.

10.7.3 For Device Type 1, define the Damping Factor:
1

DF = yiagp -~ ADF, (25)
where:

MMF.,,,,.. = calculated value from Eq 20 and

ADF, = apparatus damping factor calculated from Eq 19

for Device Type 1.

10.7.3.1 T, and ADF,, are used in Eq 22 to determine A",
These three factors are used to determine both shear modulus
and damping ratio. The computer program in Appendix X1,
which is written in Excel, solves Eq 22 by comparing the
results with Eq 20.

10.7.4 For Device Type 2, (MMF.,.)pr» by Eq 23 is a
function of J, / J, w, / ®,, and A". The computer program in
Appendix X2, which is written in Excel, compares calculated
values of (MMF.,.)ps> using Eq 23 with measured values

calc

(MMF.,,,,.)pr> by Eq 21 and provides values of A".
10.7.5 The dimensionless modulus factor is defined as:

_ )\’}2(6 B }\’Izm 2
o g T 20
where the subscripts “Re” and “Im” refer to the real and
imaginary components of A". Fig. 2 provides values of F,
versus values of 7, and and DF for Device Type 1. It also is
given by the Excel program in Appendix X1 for Device Type
1 and the program in Appendix X2 for Device Type 2.

10.7.6 Shear Modulus—The shear modulus for both Device
Type 1 and Device Type 2 is calculated from:

less frequency factor, A*, is complex having both a real G =p(o L)*F, (27)
100
10 1= 1
DF = ——— - ADF,
Ty MMF
—— ]
L9 ——0.1
—&— 0.001
0.1 1 :
0.01 0.1 1 10 100

Ta

The computer program in Appendix X1 provides values of F, and is recommended. For values of T, below 1.0, the computer program must be used to get accurate
values of F,. For values of T, above 10, F, = T, (The arrows show how the graph is used where T, corresponds to the value in Appendix X1.)

FIG. 2 Dimensionless Modulus Factor F, for Use in Eq 27 to Calculate Shear Modulus
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where

p = density of the soil specimen,

L = specimen length,

o, = system resonant circular frequency = 2nf,, and

F, = dimensionless modulus factor from Eq 26 for both

Device Type 1 and Device Type 2.

10.8 Damping Ratio:

10.8.1 Damping Ratio from Steady State Vibration—The

damping ratio for both devices is calculated from:
7}\‘Re)\‘lm

D=
M = M

(28)

10.8.2 Damping Ratio from Free Vibration—This method
only applies to Device Type 1. The transducer that is used to
determine resonance must be used to obtain the amplitude
decay curve. Determine the system logarithmic decrement

from:
(1 A,
o= ; In An+1 (29)
where:
A, = amplitude of vibration for first cycle after power is
cut off,
A,., = amplitude of vibration for (n + 1)™ cycle of free
vibration, and
n = number of free vibration cycles which must be 10 or

less.

10.8.2.1 For apparatus where the active-end platen is re-
strained by a spring, a system energy ratio must be calculated

from:
I EAY A
ST‘F“<7)<7,>

(30)

100.0%
Q
£ 10.0% -
o [
B |
(1]
a
c
Q
£
S 1.0% -
Q
o
wn
0.1%
0.01 0.1

where:
F

a

= dimensionless modulus factor for torsional motion
from the computer program or Fig. 2.

For other apparatus, the system energy ratio is zero. System
damping by amplitude decay is given by:

8 ysrem = [0 (1 + ;) — 5,8] (31)
Calculate D, from d,,.,, by:
Dyyrem = W (32)
system
Damping in the specimen then is calculated from:
D=[D,,., — D,J100% (33)
where D, is given by:
ADF,
«~ 2F, (34)

and F, is given by Eq 26 with ADF, from Eq 19. Values of
D% by Eq 33 versus system logarithmic decrement may be
obtained by use of Fig. 3.

Free vibration solutions do not apply to Device Type 2.

10.9 Strain Amplitude:
10.9.1 The average shear strain amplitude, v,,,, shall be
calculated from:

Vurel %) = S55(0, = 0,) 100% (35)
where:
6, = magnitude of the rotational motion at the active end,
0, = 17/ 'kp For Device Type 2 (For Device Type 1, 6, =0),
L = specimen length,

1 10

System Logarithmic Decrement, Jgystem

The arrows show how the graph is used.

FIG. 3 Specimen Damping Ratio D as a function of system logarithmic decrement &, .,

10

and D, for Device Type 1.
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Tae = 0.4d is the default value (values between 0.33d to
0.40d may be used if documented in the report, and
d = specimen diameter.

11. Report: Test Data Sheet(s)/Form(s)

11.1 The methodology used to record data as given below,
electronically or on the test data sheet(s)/form(s), with refer-
ence to 1.4.

11.2 Record as a minimum the following general informa-
tion (data):
11.2.1 Date of test, operator name, location of test.

11.3 Record as a minimum the following Apparatus Char-
acteristics data for Device Type 1:

11.3.1 Apparatus name, model number, and serial number;

11.3.2 Active-end rotational inertia (J,);

11.3.3 Apparatus resonant frequency (f,,) for apparatus with
a spring attached to the top platen;

11.3.4 Apparatus damping coefficient (c,);

11.3.5 The torque motor rating (TMR);

11.3.6 The motion transducer calibration factor (S,).

11.4 Record as a minimum the following Apparatus Char-
acteristics data for Device Type 2:

11.4.1 Apparatus name, model number, and serial number;

11.4.2 The torque transducer stiffness (k,);

11.4.3 The torque transducer sensitivity (77,,,);

11.4.4 The passive end inertia (J,);

11.4.5 The motion transducer calibration factor (S).

11.5 Record as a minimum the following Specimen Char-
acteristics data:

11.5.1 A visual description and origin of the soil shall be
given, including name, group symbol, and whether intact or
remolded.

11.5.2 Initial and final specimen mass, diameter, length,
void ratio, water content, and degree of saturation.

11.5.3 Specimen preparation procedures and test setup pro-
cedures should be outlined.

11.6 Record as a minimum the following Static Test Con-
ditions data:

11.6.1 A complete description of the static axial and lateral
stress conditions shall be given, including total stresses and
pore water pressures, drainage conditions, and the procedures
used to measure applied stresses, pore pressures, length
change, and volume change.

11.7 Record as a minimum the following for Each Data Set:

11.7.1 Approximate time of vibration at this strain
amplitude,

11.7.2 Cell pressure, backpressure or pore pressure, axial
stress,

11.7.3 Specimen length, volume, and density,

11.7.4 Radius used for calculating average shear strain if
different from 0.4d, and

11.7.5 System resonant frequency, strain amplitude, shear
modulus, and damping ratio.

12. Precision and Bias

12.1 Precision—Test data on precision are not presented due
to the nature of the soil or rock, or both materials tested by this
standard. It is either not feasible or too costly at this time to
have ten or more laboratories participate in a round-robin
testing program. In addition, it is either not feasible or too
costly to produce multiple specimens that have uniform physi-
cal properties. Any variation observed in the data is just as
likely to be due to specimen variation as to operator or
laboratory testing variation.

12.2 Subcommittee D18.09 is seeking any pertinent data
from users of these test methods that might be used to make a
limited statement on precision.

12.3 Bias—There is no accepted reference value for these
test methods, therefore, bias cannot be determined.

13. Keywords

13.1 amplitude; confining pressure; damping; dynamic
loading; elastic waves; frequency; laboratory tests; nondestruc-
tive tests; resonance; shear modulus; shear tests; soils; strain;
stress; torsional oscillations; transfer function method; triaxial
stress

ANNEXES

(Mandatory Information)

Al. THEORY

INTRODUCTION

The shear modulus shall be defined as the elastic shear modulus of a uniform, linearly viscoelastic
(Voigt model) specimen of the same mass density and dimensions as the soil specimen necessary to
produce a resonant column having the measured system resonant frequency and response due to a
given vibratory torque input. The specimen properties can be characterized by a specimen stiffness
transfer function matrix (4, 5, 6, 7) which greatly simplifies the solution to the system. The
stress-strain relation for a steady-state vibration in the resonant column is a hysteresis loop. This
modulus, G, will correspond to the slope of a line through the end points of the hysteresis loop. The
section on calculations provides for computation of shear moduli from the measured system torsional
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resonant frequencies. The energy dissipated by the system is a measure of the damping of the soil.
Damping will be described by the shear damping ratio, D, which is analogous to the critical viscous
damping ratio, c/c,, for a single-degree-of-freedom system (3).

Al.1 Values of damping determined in this way will corre-
spond to the area of the stress-strain hysteresis loop divided by
four times the elastic strain energy stored in the specimen at
maximum strain. Methods for determining damping ratio are
prescribed later. In viscoelastic theory, it is common to use
complex moduli to express both modulus and damping. The
complex shear modulus is given by:

G¥*=G(1 +i2D) (A1.1)

where i = \/—1

A1.2 Equilibrium Equations

Al.2.1 The equation describing the rotation of the active-
end platen for a given applied torque to the active end (Device
Type 1) is given by (5, 7):

0, 1
= (A1.2)

2
) o*J
arp! et 0%, *ioc,tk,

T

where:

= the rotation at the active (top) end,

= the torque applied to the active end,

the excitation circular frequency (= 2xf),

the polar mass moment of inertia of the specimen,

= the total polar mass moment of inertia of the top
platen system including the apparatus inertial contri-
bution calculated from calibration,

= the apparatus damping coefficient for the active end,

the apparatus stiffness, and

* = the complex dimensionless frequency.

o D
|

appl

~<8
[

Q

~ 0
1]

Al.2.2 The equation describing the rotation at the active
end platen for torque measured at the passive end platen
(Device Type 2) is given by (5, 7):

®2J

0, iramr Otk
S ) o~ (A1.3)
PAFESInA*
where:
6, = the rotation at the active (top) end,
77+ = the torque measured by the torque transducer at the

passive end,

J = the polar mass moment of inertia of the specimen,

J, = the total polar mass moment of inertia of the bottom
platen system including the torque transducer inertial
contribution calculated from calibration,

k, = the torque transducer stiffness, and

A* = the complex dimensionless frequency.

A1.2.3 The complex dimensionless frequency, A% is a

parameter that characterizes the properties of the specimen as

defined by (5, 6, 7):

oL

I — (Al.4)
G[1 +i2D]

p
where:
G = shear modulus of the specimen,
D = damping ratio of the specimen,
L = length of the specimen, and
p = the specimen density.

A2. APPARATUS PROPERTIES

A2.1 Alternate Procedures for Active End Platen Inertia

A2.1.1 If all components do not have simple geometry, an
alternative procedure that involves a metal calibration rod of
known torsional stiffness may be used. One end of the rod shall
be rigidly fixed and the other end shall be rigidly fastened to
the active-end platen. Since it may be very difficult to fasten the
calibration rod to the platen without adding rotational inertia, it
is recommended that an auxiliary platen be monolithic with the
calibration rod or be permanently fastened by welding, etc. The
torsional stiffness of the calibration rod should be chosen such
that the system resonant frequency with the calibration rod in
place is near the middle of the range of system resonant
frequencies anticipated for soil testing. Several calibration rods
may be necessary to account for different specimen sizes or

widely varying specimen stiffnesses. With the calibration rod
in place, determine the low-amplitude system resonant
frequency, f,,,. The rotational inertia of the active end platen
system with auxiliary platen, J,, is calculated from:

k»‘od

I PR Fo | (A2.1)

where:

k,.q = torsional stiffness of calibration rod,
= (I,G)L,

I, = polar moment of inertia of calibration rod,
= (zd*)/32,

d = calibration rod diameter,

G = shear modulus for calibration rod material,
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f, = apparatus torsional resonant frequency as described in
8.3, and
L = Length of the calibration rod.

A2.1.1.1 If the auxiliary platen is not identical to the one to
be used in testing, the difference between its rotational inertia
and that of the platen for soil testing must be taken into account
by use of Eq A2.2 to determine the value of J,, for use in testing
specimens.

J

L=J = T, (A2.2)

where:

rotational inertia of the active end platen system with
auxiliary platen,

rotational inertia of the calibration rod platen, and

= rotational inertia of the platen for testing soil.

The foregoing equations assume that the rotational inertia of
the calibration rods is much less than the corresponding values
for the active-end platen system.

A2.1.2 A second alternative procedure is to couple the metal
calibration rod to the platens in place of the specimen and then
use the procedures of the Calculations in Section 10 to
back-figure the active end inertias from the known moduli of
the rod.

A2.1.3 A third alternative would be to follow the procedure
in A2.3, substituting k,,,, for k, and J,, for J,.

A2.2 Alternate Method for Determining the Apparatus
Damping Coefficient

A2.2.1 With the apparatus vibrating at the resonant
frequency, cut off the power to the excitation device and record
the decay curve for the vibration of the apparatus. From the
decay curve, compute the logarithmic decrement for the
apparatus, o, as follows:

=l A 2
8,= il 5 (A2.3)
where:
A, = amplitude of vibration for first cycle after power is
cut off,
A,., = amplitude for (n+1)" cycle, and
n = number of free vibration cycles.

13

The apparatus damping coefficient, c,, is given by:
2108

av'a a

(A2.4)

c, =

where:

Ja

torsional motion resonant frequency measured during
apparatus damping determination,

J, = active-end rotational inertia for calibration conditions,
and
J, = apparatus logarithmic decrement.

A2.3 Alternative Procedure for Determining the Passive
End Rotational Inertia, J,, and Torque Transducer
Stiffness

A2.3.1 This procedure (5) makes use of masses with known
inertias fastened one at a time to the passive end platen. The
procedure involves mounting the transducer on a fixed base
and measuring the free vibration frequencies with two different
known inertias attached to the bottom platen. Free vibration is
initiated by manually “tapping” the attached inertias and the
output of the torque transducer is used to measure the frequen-
cies. The results provide the following two equations:

1 k
_ P
h=2a N7+, (A2.5)
and
1 k,
5= I+,

where f, and f, are the measured frequencies corresponding
to J, and J,, k,, is the transducer stiffness and J, is the passive
inertia. One of the know inertias attached is quite large relative
to J, and the other on the same order of magnitude. Solving Eq

P
A2.5 to eliminate k, provides:
ﬁjz _ﬁ‘ll
=1z -1 A2.
hTTER (A2.6)
k,=2nf)(J, +7,)=2nf) ), + 1)  (A2.7)

The value of J, must be adjusted to the test conditions; for
example, the inertia of the porous disks that were not included
in the inertia at the time of calibration must be added to J,
similar to the procedures described by Eq A2.2 for the active

end inertia.
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A3. SYMBOLS AND UNITS

TABLE A3.1 Symbols and Units

Symbol Units Description Reference
A [any dimension] amplitude of vibration from a decay Eq A2.3
curve
ADF, [-] apparatus damping factor Eq 19
C, [Nemes/radian] apparatus damping coefficient Eq 10
Co [Nemes/radian] passive end platen torque transducer 6.2
damping
CR;, CR, [Amps] torque amperage reading at 0.707 and Eq 11
1.414 times o,
D [-] Typ. Exp. in % specimen damping capacity 3.2.1, Eq 28, and Eq 33
D, [-] apparatus damping capacity Eq 34
Dsystem [-] system damping capacity Eq 32
[-] Typ. Exp. in % damping factor Eq 25
d [m] specimen diameter 7.2
d; [m] diameter if 1" solid concentric Eq 6 and 8.2
cylindrical component of active end
platen
DT1 Device Type 1 3.2.2
DT2 Device Type 2 3.2.3
f [Hz] frequency 3.2.8,Eq 8
f. [Hz] system resonant frequency 3.2.8,9.8.1.1, and 9.3.2.1
F, [-] dimensionless modulus factor Eq 26
f, [Hz] Device Type 1 resonant frequency 6.2 and Eq 9
without a specimen
G* [Pa] complex dynamic shear modulus 3.2.4 and Eq A1.1
G [Pa] equivalent elastic shear modulus 3.2.5 and Eq 27
J [kgem?] rotational inertia of specimen Eq 17
Js [kgem?] rotational inertia of the active-end Eq 6 and Eq 7
platen
J; [kgem?] rotational inertia of " mass Eq7
Jp [kgem?] rotational inertia of the passive end of Eq 14
the apparatus
passive platen [kgem?] rotational inertia of the passive platen Eq 14
sense head [kgem?] rotational inertia of the torque Eq 14
transducer sensor head
k [(Nem)/radian] rotational spring constant Eq 12
k, [(Nem)/radian] apparatus spring constant Eq 9
Ko [(Nem)/radian] passive end platen torque transducer Eq A1.3 and 6.2
stiffness
Kroa [(Nem)/radian] stiffness of a metal rod representing a A2.1 and Eq 12
soil specimen
L [m] specimen length Eq 35
M [ka] mass Eq 16
M; [ka] mass of ith solid component Eq7
MMF .0 [-] calculated modified magnification Eq 22 and Eq 23
factor
MMF .0 [-] measured modified magnification Eq 20 and Eq 21
factor
n [-] number of components of top platen Eq7
system
C, C, [radians/amp] torque / current characteristics Eq 11
S, [mV/g] accelerometer transducer sensitivity Eq 2
S, [mV/m/s] velocity transducer sensitivity Eq 3
Sy [mV/m] displacement transducer sensitivity Eq 4
Sy [mV/radian] rotation transducer sensitivity 8.1
Sy [-] system energy ratio Eq 30
Tavg [m] average specimen radius used for Eq 35
average strain calculation
r [m] distance from rotational axis to center Eq7
of mass of M;
t [s] time
T, [-] active-end inertia factor Eq 18 and 10.4.1
T™MR [(Nem)/Amp] torque motor rating Eq 12
Trdg [Amps] torque motor input Eq 13
TTesns [(Nem)/mV] torque transducer sensitivity Eq 12
TTrdg [mV] torque transducer voltage output Eq 15
v [m?3] volume of specimen Eq 16
k% [-], Typ. Exp. in % specimen shear strain Eq 35 and 3.2.7
Yavg [-1, Typ. Exp. in % average specimen shear strain Eq 35

14
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TABLE A3.1 Continued

Symbol Units Description Reference
3 [-] logarithmic decrement Eq 29
8, [-] apparatus logarithmic decrement Eq A2.3
Ssystem [-] system logarithmic decrement Eq 31

* [-] complex dimensionless frequency Eq A1.2, Eq A1.3, and Eq A1.4
p [kg/m3] soil mass density Eq 16
0 [radians] amplitude of rotation Eq 5 and Eq 10
0, [radians] rotation magnitude at the active end 6.6
0, [radians] rotation magnitude at the passive end Eq 35
o, [Pa] effective axial stress Eq 1
Tappl [Nem] amplitude of applied torque Eq 13
Trr [Nem] torque measured by torque transducer Eq 15 and 6.6
® [radianses™] circular frequency (2enef) Eq 20 and Eq 21
o, [radianses™] resonant circular frequency (2eref,) of 9.3.1.1 and 9.3.2.1

system

APPENDIXES

(Nonmandatory Information)

X1. DEVICE TYPE 1 COMPUTER PROGRAM FOR FIXED BASE RESONANT COLUMN DATA REDUCTION

X1.1 The program assumes that the rotation and torque
were determined at the fundamental mode frequency where the
torque applied to the active end of the specimen is ninety
degrees out of phase with the resulting rotation of the active
end system. (See Fig. X1.1)

X1.1.1 Settings for Solver Pop-Up for Both Device Type 1
and Device Type 2:

X1.1.1.1 With ResColSolv-DT1 loaded, select the Data tab
at the top of the sheet. In the Analysis panel on the far right of
the menus, select Solver’. The Solver Parameters pop-up
screen will appear as shown Fig. X1.2. Click on the Set
Objective button at the end of the open box and select the cell
in the spreadsheet where the Objective Function is located.
This is typically cell B46 for the Device Type 1 program and
cell B48 for the Device Type 2 program.

> If the Solver button does not appear in the Analysis window, it must be added
by going to the File tab and selecting Options>Add-ins.

15

X1.1.1.2 In the To: line always select Min. In the By
Changing Variable Cells: click the button at the end of the
open box and select the cells in the spreadsheet corresponding
t0 Ag. and Ay, which are cells $B$33:$B:$34 for Device Type
1 and $B$37:$B:$38 for Device Type 2. In the Subject to the
Constraints: box, click Add and select the cell for the
imaginary component of A;,," (cell B34 for Device Type 1 and
cell B38 for Device Type 2) and require it to be <=0. Be sure
to uncheck the box for Make Unconstrained Variables
Non-Negative below the previous window. Finally, press the
Solve button on the lower right of the pop-up box. The pop-up
box will disappear and after a few seconds a Solver Results
box will appear (see Fig. X1.3). Press OK in the left middle of
this box to return to the spreadsheet with all of the calculations
completed. Once the Solver parameters are set, they will
remain the same until changed and are saved with the program.
To run the program again, just click on Solver in the
Data>Analysis panel and then press the Solve button.
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A B C D
ResColSolv-DT1 [Resonant Column Solver for Device Type 1)
Vincent P. Drnevich and Salim Werden, 2014-03-05
Programmed in Microsoft Office Excel 2010
Color Codes: | User Input | Instructions | Results
Test Description: | 425-52 plastic specimen Test Date: | 40607
Apparatus Desc.: | Purdue Resonant Column Operator: | VPD
Farameter Value nits MNotes
Test Data
Test Ident. Info. | 40607.7043865741 Date and Time
Torgue|0.0822 N-m Sect. 5.4
Fatation]0.00132 Rad Sect. 8.1
Phasze angle|90 Degrees
Bes. Freq.|48.6 Hz Sect 931
Specimen Data
Lenath|0.142 rm Spec. Length
Diarmeter|0.0709 m Spec. Diameter
has=|0.609 kg Total Spec. Mass
o/ | =Mass™Diameter” 28 kg-m"2 Spec. Rot. Inertia
Apparatus Calibration Information
./, |0.00317 kg-rn"2 Sect. 8.2
£, |5 Hz Sect. 83
¢, |0.0356 [N-rn-s)fRad Sect 8.3
Solution Parameters
2 |=Massl(PI[}"Diarneter” 24 Length) kg3 Spec. density
w |=2"PI()"Res._Freq. Radls Circ. Res. Freq.
7 . |=JdJ(1-[f4Res._Freq)"2) Active End Inertia Ratio
A\ | =Rotationd Torque™w "2 Meas. Mod. Mag. Facter
AOF , |=calJw) Apparatus Darmp. Factor
LF=f Ba==40F | 7 |=(TMMF-ADF a) Darmnping Factor
Program Statements
h.p | 0.336665867222115
| -0.0279464883888515
1% =COMPLE X[B33.B34)
Siniz.™)|=IMSIN(B35)
Cos(1.7)]|=IMCOS[B35)
tan(2.™]| =IMDIV(B36.B37)
i tan(.) | =IMPRODUCT(B35.838)
ixtan(i*)) | =IMDIV(1.B39)
/T -iTF7 ... |=COMPLEX(Ta,B31)
{7 -FTF7 o |=BAD
T wewe |=IMREAL(B42)
OF e |5IMAGINARY(B42)
£, |=(IRe"2-lm"2){(IRe"2+1lm"2)"2
Objective Function|=IMABS(IMSUB(B41.840])
To get solution, put cursor on Objective Function cell B45 and click on: Data>Solver. Then press Selve and OK.
Calculated Results
& |=r_"w"2"Length”2"B451000000 Mpa
D |=-{IRe™Imd(IRe"2-lm"2])*100 %
7 |=0.4"DiameterRotatiordlength™100 ot

FIG. X1.1 Computer Program for Device Type 1

16
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.
Solver Parameters ﬂ

Set Objective Dbjective Functon}
To: ) Max @ Min 7 Value Of: 0
By Changing Variable Cells:
| $8432:$8533 £
Subject to the Constraints:
[Im <=0 - Add

‘ié

["] Make Unconstrained Variables Non-Negative
Select a Salving Method: |GRG Nonlinear ]

]

Solving Method

Select the GRG Nonlinear engine for Solver Problems that are smooth nonlinear, Select the LP Simplex
engine for linear Solver Problems, and select the Evolutionary engine for Solver problems that are
non-smooth.

sve | [ ome

FIG. X1.2 Solver Pop-Up Screen

17
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ResColSolv-DT1 [Resonant Column Solver for Device Type 1)
Vincent P. Drnevich and Salim Werden, 2014-03-05
Programmed in Microsoft Office Excel 2010
Color Codes: | User Input !nsl:'uctlong Results
Test Description: | 425-52 plastic specimen Test Date: | 35201
Apparatus Desc.: |Purdue Resonant Column Operator: | VFD
Parameter Value Units Notes
Test Data
Test Ident. Info. IS 16:54 Date and Time
Torque 8.22E-02|N-m Sect. 8.4
Rotation 1320E-03|Rad Sect. 8.1
Phase angle 90.0|Degrees
Res. Freqg. 48.6|Hz Sect 9.3.1
Specimen Data
Length 0.142|m Spec. Length
Diarmeter 0.0709|m Spec. Diameter
Mass 0.603 kg Total Spec. Mass
o 3.827E-04]kg-m"2 Spec. Hot. Inertia
Apparatus Calibration Information
o 0.00317|kg-rn"2 Sect. 8.2
£, 0|Hz Sect. 8.3
Lo 0.0356| (N-m-s)fRad |Sect 8.3
Solution Parameters
o 1086.3| kam ™3 Spec. density
w 305.4|Rad's Circ. Res. Freq.
i 8.284 Active End Inertia Ratio
AdtagE 5.727E-01 Meas. Mod. Mag. Factor
ADF , 3.05E-01 Apparatus Darnp. Factor
DF=f - A0F | ] 144133 Darnping Factor
Program Statements
0.336666
et -0.027946

A

0.336665867222115-0.0279464883888515i

Sin[i.™)

0.330470353108583-0.02638104 345683781

Cos(r7)

0.944223318453311+0.00923310011276831

tan(”]

0.349683313135125-0.031358574 76648691

1. tan(”)

011685007 3805322-0.0203297826287 247

Vixtan(i*))

8.30653883656132+ 1 44518632676003i

(7P e

8.28398847873597+1.44139273113328i

{7 -FTFT e

8.30653883656132+ 1. 44518632676003

/2 2 ke

8.307

LF Cale

14452

'a

86424

Objective Function

2.23E-02

To get solution, put cursor on Objective Function cell B45 and click on: Data> Sal

ver. Then press Solve and O

“Calculated Results Ashrn-au\v & Drnevich [1994)
&5 17.65|Mpa 17.69
2 8.359|% 8.357
7 0.0264| % 0.0263

FIG. X1.3 Example Computer Solution for Device Type 1

18
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X2. DEVICE TYPE 2 COMPUTER PROGRAM FOR FIXED BASE RESONANT COLUMN DATA REDUCTION

X2.1 For this device, a torque transducer is mounted in the
specimen base. Frequency is adjusted to obtain the maximum
amplitude of rotation and a measurement of the real and
imaginary components of the rotation, relative to the torque is
made. The program is written to accommodate a torque

transducer damping factor, Cps but with the specifications
placed on the torque transducer in 6.4, measured values of c,
are typically two orders of magnitude below values that would
affect the calculated specimen damping and hence, ¢, can
safely be set to zero. (See Figs. X2.1 and X2.2.)

B C D

1 ResColSolv-DT2 (Resonant Column Solver for Device Type 2)
2 Vincent P. Drnevich and Salim Werden, 2014-03-08
3 Programmed in Microsoft Office Excel 2010
4
5 Color Codes: | User Input Instructions Results
b
7 Test Description: ]| A25-52 plastic specimen Test Date: | 513201
8 Apparatus Desc.:|GCC Sustem B Operator:| YJP
9 Farameter Value Units Motes
10 Test Data =
1 Test Ident. Info. AZ552F Typically, Date and Ti{
2 Mag. 8,)0.00788 Fiad Sect. 8.1
13 | Magnitude of 8 j140.00303 Rad{M-m) Sect. 10.6.2
W Phase of & }14,|-8.98 degrees Sect. 106.2
B Res. Freq.|63.8 Hz Sect 9.3.2
16 Sp 1 Data
7 Length|0.142 m Spec. Length
1B Diarneter|0.0709 m Spec. Diamneter
1 Mass|0.609 kg Total Spec. Mass
20 ./ |=Mass™Diameter" 28 kg-mn"2 Spec. Rot. Inertia
21 Apparatus Calibration Information
22 J, |0.001243 kg-m"2 85
23 ¢, |0.0001 [N-m)}iRadls  |Sect 6.2, A2.3
24 A, 18880 [N-rn)iRad Sect 6.2, A23
25 w, |=SORT(B244Jp) Fad's
26 £, |=B23B25"Jp)
27 Solution Parameters
28 2 |=MasF[PI[)"Diameter” 24™Length] kalm™3 Spec. density
29 w |=2"PI[)"Res._Freq. Fad's Circ. Res. Freq.
30 w/lw, |=wkop
N 1,y |=B12B13 N-m cell B12icell B13
32 8, |=tTTkp Rad cell B31B24
33 Re(8 ftyy) | =B13"COS(B14PI()1180) Rad(N-m) B13=COS(B14~PI(N80)|
34 Im(8 juyp) | =B13*SIN[E14~PI()180) Rad/(N-rn) B13~SIN(B14FI(}180)
35 AR ... |=COMPLEX[Jw"2"B33 Jw"2"B34)
36 Program Statements
37 Est &g, |0.438977061379225
38 Est i,,|-0.0369871604641393
39 1.7 =COMPLE X[B37 B38]
40 Sin(.7) | =IMSIN(B39)
41 Cos[i.™)|=IMCOS[B39]
42 Y (whe)? [=0Jp™(B30)°2
43 1- (who,)® [=1B3072
44 £ (whe,] | =B26™B30
45 (wh,)® « /00 [who,)|=COMPLEX(B43,844)
46 A . |=IMSUMIIMPRODUCT(B42,B41) IMPRODUCT(B45.83
47 £, |=1Re"2-m"2)i{IRe"2+Ilm"2) "2
48 _Objective Function|=IMABS[IMSUB[MMF B48])

To get solution, put cursor on Ubjective Function cell (B48) and click or: Data> Solver. Select cells Ba7 538 as the |
o Changing Yariable Cells. Finally press Solve and OK.
50 Calculated Results
5 & |=r_"w 2"Length” 2"B471000000 Mpa
52 D =R miiRe 2-Im 2)) 100 %
53 ¥|=0.4"Diareter™{Fotation-B32){Lenath™100 7

FIG. X2.1 Computer Program for Device Type 2
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A B Cc D

1 ResColSolv-DT2 [Resonant Column Solver for Device Type 2)

2 Yincent P. Drnevich and Salim Werden, 2014-03-08

3 Programmed in Microsoft Office Excel 2010

4

5 Color Codes: | User Input w:mg Results
&

7 Test Description:| 426-52 plastic specimen Test Date:| 5137201

8 Apparatus Desc.: | GCC S!slem B Operator:| YJP

9 Farameter Walue Lnits Notes
10 Test Data _

1" Test Ident. Info. A2652F Typically, Date and Time
12 Mag. 2, 7.880E-03| Rad Sect. 8.1

13 Magnitude of & fzvr 3.0900E-03| Radi(N-m) Sect. 10.6

L Phase of &,k -8.980| degrees Sect. 106

15 Res. Freq. 63.8|Hz Sect. 9.3

18 Specimen Data

7 Length 0.14205] m Spec. Length

18 Diameter 0.07086| m Spec. Diameter

19 Mass 0.6 kg Total Spec. Mass
20 W 3.821E-04]| kg-m"2 Spec. Rot. Inertia
21 Apparatus Calibration Information

22 o, 0001243 kg-m"2 Sect. 8.2

23 &, 0| [N-m}{Radis

24 R 8880|(N-m){FRad  |Sect.83

25 w, 2672.8| Radis

26 £, _ 0.000E.00

27 Solution Parameters

28 g 1086.8| kalm"3 Spec. density

29 w 400.9| Radis Circ. Res. Freq.

30 wlw, 014992

N =g 2.550E-00 N-m cell El2fcell BI3
32 8, 2.872E-04| Rad cell BINE24

33 Re(s. k) 3.0521E-03| Radi[N-m) | BIFCOS(BI'FIE0]
34 Im(2.tzvr) -4 8230E-04| Radi{-m) | BIZSIN(BI4'PI#180)
35 ASE .., 0.187403141385453-0.02961469725672351

36 Program S ts

3 Est. ig, 0438377

38 Est, by -0.036985

39 Lt 0.43897 71663654 28-0.026985144 95112921

40 Sinfi.") 0.425304554081505-0.03343610009357 281

41 Cos(i") 0.305308028383574.0.0157 2?32165223ﬂ

42 Y, faks)’ 0.006314728

43 12 £ (whs,) 1

OB, (w1520, ofe, Neost * 0.006262402017 34008.0.00010271875704 7384

45 [He e, Y1728, (wh , ) sin" 0.181288822902652-0.029745125880321i

46 ARE 0157552224 919992-0.029636 393830984 7i

47 F. 5020171

48 Objective Function| 145E-04

To get solution, put cursor on Objective Function cell (B48) and click on: Datas Solver. Select cells B37:B38 as the Changing Variable

49 Cellz. Finally press Solve and OFK.
50 Cal d Results Aishmawy & Drnevich (1334]
51 & 17.90] Mpa 17.69
52 7 84 sgl % 8.357
53 ¥ 0.151] % 0.0269

FIG. X2.2 Example Computer Solution for Device Type 2

X3. TYPICAL BEHAVIOR OF SOIL IN RESONANT COLUMN TESTING AND SUGGESTED TEST STRATEGIES

X3.1 The shear modulus of a soil is a maximum value and
relatively constant at shear strains below about 0.001 %, hence
the commonly used terms: initial shear modulus, G, G, etc.
The damping ratio of a soil is at a minimum and relatively
constant in this same range of shear strain. At shear strains
greater than about 0.001 %, the soil’s shear modulus will be
lower and the damping ratio higher. At shear strains greater
than about 0.01 %, some soil degradation will occur during the
resonant column measurements, further changing the shear
modulus and damping ratio.

X3.1.1 Initial Shear Modulus and Damping Ratio Deter-
mined as a Function of Time:

20

X3.1.1.1 For a given static axial and lateral stress condition
in a resonant column test, the initial shear modulus and
damping ratio of a soil are not constant, but vary with time. The
initial shear modulus and damping ratio variation during
primary consolidation of the test specimen is dependent on the
test conditions and changing effective stress, i.e., the direction
of static axial and lateral stress change (loading or unloading),
the magnitude of the stress change and the drainage conditions
of the specimen. Well beyond the end of primary consolidation,
initial shear modulus typically increases and damping ratio
decreases linearly with the logarithm of time.
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X3.1.1.2 Since the initial shear modulus and damping ratio
of a soil at given static axial and lateral stress are time
dependent, ‘reference’ values of these parameters can be taken
during primary consolidation and after it is complete and then
continue to be taken with time for one log cycle of time after
primary consolidation is complete. Typically, data are taken for
1000 minutes or one day (1440 minutes) after the application
of the static axial and lateral stress. These measurements
should be taken at a shear strain of less than about 0.001 %. If
“aging effects” (the trend of the change of initial shear modulus
and damping ratio with time after primary consolidation is
complete) are to be determined for a particular increment of
static axial and lateral stress, measurements can be taken
periodically at a shear strain level below about 0.001 %,
preferably all at the same shear strain.

X3.1.2 Shear Modulus and Damping Ratio Determined as a
Function of Strain:

X3.1.2.1 In order to determine the variation of shear
modulus and damping ratio with shear strain of a soil in a
resonant column test, different measurements can be made
starting with a very low excitation torques and then at
progressively greater excitation torques. These measurements
should be made when the time-effect on modulus and damping

(1) Clayton, C.R.L, Priest, J.A., Bui, M.T., Zervos, A. and Kim, S.G.,
“The Stokoe resonant column apparatus: effects of stiffness, mass and
specimen fixity,” Géotechnique, Vol. 59, No. 5, 2009, 429-437.
Picornell, M., Nazarian, S., and Almadhoun, A. Y., “Effect of
Specimen Coupling on the Torsional Resonant Column Test,” Geo-
technical Testing Journal, Vol. 36, No. 4, 2013, pp. 1-8, doi:10.1520/
GTJ20120104. ISSN 0149-6115.
Ashmawy, A., and Drnevich, V.P. (1994) “General Dynamic Model
for the Resonant Column/Quasi-Static Torsional Shear Apparatus,”
Geotechnical Testing Journal, ASTM, Vol. 17, No. 3, September, pp.
337-348. (doi:10.1680/geot.2007.00096).
(4) Wolf, John P., Dynamic Soil-Structure Interaction, Prentice Hall
International, Inc., London, 1985, pp.118-120.
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will be small, well beyond the end of primary consolidation at
the end of an static axial and lateral stress increment.

X3.1.2.2 As the shear strain is increased beyond about
0.01 %, some degradation of shear modulus and increase in
damping ratio occur with cycles of vibration. The amount of
degradation or increase is dependent on strain level, how long
vibrations are applied to take the measurement (number of
oscillations) and any degradation at previous measurements
which were also above 0.01 % shear strain. It is suggested that
a low strain level measurement is taken immediately after
every sequence of large strain measurements or for drained
tests, after excess pore pressures have dissipated; the low strain
result can be used to indicate that degradation has occurred by
being different from the initial low strain measurement.

X3.1.2.3 Measurements made at very large strains in the
resonant column test (for example, 0.1 % and higher) will
cause more significant degradation in the test specimen. If
shear modulus and damping ratio are to be determined at the
end of several consecutive static axial and lateral stress
consolidation increments, it may be preferable to limit the
maximum strain level in intermediate consolidation increments
and only go to the maximum strain level at the end of the final
increment.

(5) Werden, Salim K., Drnevich, Vincent P., Hall, John R., Jr., Hankour,
Chafik, Conlee, Carolyn T., and Allen Marr, W., “New Approach to
Resonant Column Testing,” Geotechnical Testing Journal, Vol. 36,
No. 2, 2013, pp. 1-9, doi:10.1520/GTJ20120122.

Ashlock, Jeramy C., Drnevich, Vincent P., and Pak, Ronald Y. S.,
“Strain Measures for Transfer Function Approaches to Resonant
Column Testing,” Geotechnical Testing Journal, Vol. 36, No. 4, 2013,
pp. 1-11, doi:10.1520/GTJ20120130. ISSN 0149-6115.

Drnevich, Vincent P., Werden, Salim, Ashlock, Jeramy, and Hall, John
R. Jr., “Applications of the New Approach to Resonant Column
Testing,” Geotechnical Testing Journal, Vol. 38, No. 1, 2015, pp.
1-17, doi:10.1520/GTJ20140222. ISSN 0149-6115
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SUMMARY OF CHANGES

In accordance with Committee D18 policy, this section identifies the location of changes to this standard since
the last edition (2007) that may impact the use of this standard. (October 1, 2015)

(1) Changed title from ‘“Modulus and Damping of Soils by
Resonant-Column Method” to “Modulus and Damping of Soils
by Fixed-Base Resonant-Column Device”, adding the qualifier
“Fixed-Base” and changing “Method” to “Devices.”

(2) Removed all references to longitudinal motion including
calibrations, measurements, calculations, and reporting of data.
(3) Removed all references to free-free boundary conditions
and motion including calibrations, measurements, calculations,
and reporting of data. (A separate standard is being drafted to
cover these boundary conditions.)

21

(4) Replaced “ambient stress” with “static axial and lateral
stress” throughout.

(5) Expanded the standard to cover two device types: a) Device
Type 1 is the conventional fixed-base and free top or fixed base
and spring top, with calibrated torque applied to top, measuring
rotation at top, and adjusting frequency for phase of 90 degrees
between rotation and torque; b) Device Type 2 is similar to
Device Type 1 except, an uncalibrated torque is applied to the



Ay p4o1s - 15

top, the rotation of the top is measured, a torque transducer at
the base of the specimen measures the torque, and frequency is
adjusted to resonance as defined as the maximum rotation of
the top.

(6) Added a steady-state vibration method for apparatus damp-
ing calibration.

(7) Made use of the transfer function approach to establish
governing equations in complex variables for both device
types.

(8) Placed much of the theory from Section 3 in Annex Al.
(9) Placed alternate methods for determining apparatus calibra-
tions in Annex A2.

(10) Modified the amplitude decay method to account for
apparatus damping.

(11) Replaced the FORTRAN program in the Appendix with
two Excel programs, one for each device type and provided
sample outputs for both programs that tested the same plastic
specimen. The results were compared with tests on the same
specimen using prior theory.

(12) Updated the figure showing a schematic of the apparatus.
(13) Generated new figures for manually reducing data for
Device Type 1.

(14) Provided two versions of the Excel spreadsheets for
Device Type 1 and for Device Type 2, one showing the
equations in the cells and another showing calculated numbers
in the cells.

(15) Included instructions for use of the Solver routine that
comes with Excel.

(16) Added an appendix on “Typical Behavior of Soil in
Resonant Column Testing and Suggested Test Strategies.”
(17) Added references to document the transfer-function
approach, criteria for fixity, coupling of soil specimens to
apparatus platens.

(18) Subsequent to the D18 (04-14) ballot, and in response to
the D18.91 Review and the other negative votes, following is
a list of changes to the version balloted:

a) The title was changed from Method to Methods.

b) Corresponding changes were made throughout the draft.
¢) Section 3 on definitions was reworked to become consistent
with the ASTM Form and Style Manual.

d) A new table in Annex A3 provides a list of symbols with
their units, definitions, and reference location in the Standard.
e) The total harmonic distortion requirement 6.6 for the sine
wave generator was dropped because it was not necessary.

f) The title for Section 8 was changed from “Calibration” to
“Apparatus Properties”.

g) Subsection 8.1 was expanded to cover acceleration, velocity,
and displacement transducers and their sensitivities in formats
consistent with industry standards.

h) Eq. 7 in 8.2 was changed to include the polar inertia term of
an element about its axis in this transfer axis equation. This
term only had miniscule effect on the calculated inertia, but the
equation is now theoretically correct.

i) Subsection 8.3 now references the paper by Drnevich et al.
(2015) for a convenient method for determining both J, and ¢,
that makes use of the program given in Appendix X1.

j) Subsection 8.4 now includes an equation for calculating
torque applied to the specimen top.

k) Subsection 9.3 was reorganized to separate the measure-
ments for Device Type 1 and Device Type 2.

1) The title to Section 11 was changed to Report: Test Data
Sheet(s)/Form(s).

m) The data in the four spreadsheet pages in Appendices X1
and X2 were modified to show the appropriate significant
digits.

n) Added Test Method D2166/D2166M and Guide D4753 to
the Referenced Documents section.

(19) The version with the above changes was balloted at the
D18.09 Subcommittee (15-01) with closing date Feb. 9, 2015.
The term “data sheets” was removed from 6.12 Miscellaneous
Apparatus.

(20) The revised draft was balloted in the Main Committee
Ballot D18 (15-02). This resulted in including a reference to
D3740 as a note (see Note 4) in Section 8 Apparatus Properties.
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